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                                    Ch-6 
     INTRODUCTION TO MICROSOFT 

POWERPOINT 2016 
➢ Keywords 

            1. Presentation -  A collection of slides created using a presentation software. 

.           2. Slide   -   An individual page of a presentation. 

            3. Multimedia    - Consisting of text, picture, audio and video. 

           4. Placeholder   -   A rectangular box that can contains title and body text or objects such as        

picture tables, charts etc. 

EXERCISE CORNER 

      A. Tick ( ) the correct answer: - 

              1. A dotted rectangular box on a slide is called?  

                    a.   textbox                             b.   Placeholder                           c. .container 

             2. On opening a blank presentation in Microsoft PowerPoint, the default slide that appears is  

                  called? 

                   a. title slide                       b.  title and content slide             c. section header slide 

             3. Which of the following is not a presentation software? 

                   a. Open Office Impress          b. Slide Dog                                       c. macOS 

             4. To add a new slide in your presentation, you click? 

                   a. Home     New Slide           b.  Slide      Home                 c. Home        Slide show        

                5. Which of the following is a keyboard shortcut to run slide show? 

                    a. F6                                         b. F8                                             c. F5 

       B.  Fill in the blanks. Compare your answers with your classmates’ answers: -  

             

               

                 1. A slide is an individual page of a presentation.. 

                 2. The visual movements of slides are called transition. 

                 3. On clicking the file tab, a full screen File menu appears. It is known also known as backstage. 

                 4. To rotate a picture, you drag to rotate  the handle.  

                 5. The ‘picture’ option allows you to insert a picture from your computer hard disk.                  

              C. State ‘True’ or ‘False’:- 

                      1. Notes pane helps to add notes to each slide separetly.                                  TRUE 

                      2. You click inside the placeholder to type in it.                                               TRUE 

        Transitions     to rotate      hard disk           backstage view      slide         



 

                      3. To insert a new slide in a presentation, we first click the ‘insert’ tab           FALSE           

                     4. The Pictures option is available in the ‘Design’ tab.                                      FALSE 

                     5. Slide transition effects are present on the Transitions ribbon.                       TRUE 

          D. Write keyboard shortcuts for the following: 

               1. To exit the slide show                                     --                       Esc 

               2. To open a new blank presentation                  --                       Ctrl + N 

               3. To save a presentation                                    --                       Ctrl + S 

               4. To run a slide show                                        --                        F 5 

               5. To open a saved presentation                         --                        Ctrl + O 

        E) Short answer questions:- 

               1. What is a presentation? 

                Ans:- A presentation is a means of communication, it provides an easy understanding of the 

topics.           

                2.  What is  a slide? 

                 Ans:- A slide is a page just like a page in the notebook, in which one can add text, picture, 

tables, etc . 

               3. Define a placeholder. 

                  Ans: -  a. Notes pane – Notes pane helps to add notes to each slide separately.  

                               b. Slides pane – The slides pane holds thumbnails of slide.  

                              c. Ribbon – A ribbon holds a set of commands and features available in Microsoft 

Power Point       

                4. How do you add text to a slide? 

               Ans: - A dotted rectangular box that can contain title and body text or objects such as   

pictures, tables, charts, etc is called Placeholder. 

 

                 5. How do you add text to a slide? 

                  Ans: - To add text onto a slide, click inside a placeholder. Notice the cursor, follow it    and 

typing your text. 

                  6. Which ribbon provides options to insert pictures in your presentation? 

                  Ans: - Insert Ribbon. 

                  7.  What is slide transition? 

                  Ans: - The visual movements of slides are called slide transition. 

                 8. Give names of any two-presentation software. 

                   Ans:- Microsoft PowerPoint, Open Office Impress.              

  F) Long answer questions: 

      1. What is Microsoft PowerPoint? Describe steps to launch PowerPoint and start with an 

             empty presentation. 

     Ans: - Microsoft PowerPoint is truly the most widespread presentation software. It enables  

you create  your own presentation with full support of multimedia elements such as 

text,picture, audio and video.  



 

            Steps to launch Microsoft PowerPoint are:  

                   i. Click the Start button. 

                   ii. Click the All apps. 

                   iii. Click the Microsoft Office. 

                   iv. Click the Microsoft PowerPoint. 

            2. What is slide transition? Write steps to apply slide transition in PowerPoint. 

              Ans:- Slide Transitions are the visual movements of slides that you see when one slide changes   

to another in the slide show view.  

                    To apply slide transitions, follow these steps: 

                         i. Select the slide on which you want to apply transition. 

                        ii. Click on the Transitions tab and locate the Transition to this Slide group.   

                        iii. Click the drop- down arrow and select any one of your choice by clicking on 

                             it to apply on slide.  

               3. How do you insert a picture in your presentation from computer hard disk? 

               Ans: - The steps to insert an image from your computer hard disk drive are as follows: 

                          i. Go to the place where you want to add a picture. 

                          ii. Click the Insert tab and select Pictures option in Images group.  

                          iii. The Insert Pictures dialog box appears. Locate your picture in left pane  

                              and select its name in the right pane.  

                          iv. Click the Insert button. The selected picture appears on the slide. 

           4. Write the steps to save a presentation. 

              Ans: - It is important to save your work to avoid loss of data because of any hardware or 

power failure. 

                  The  steps to save a presentation are as follows: 

                       i. Click the File -> Save -> Browse. The Save as dialog box appears, if you are saving a  

file first time. 

                      ii. Choose the location , enter the name for the file in the file name box and click the Save                                        

button. 

                      The Microsoft PowerPoint saves the file name with .pptx extension.   

                                                                       Activty       
➢ Create a presentation on any one topics: - 

1. Prime Minister of India                                  2. Computers in everyday life                                        

      For example  

                    a. Create a presentation on any one topic and make the first slide a bit more innovative. 

                  b. Take one slide and add topic related picture and write about few lines. 

                  c. Use transition effects and save your file and print first slide and paste it in your notebook 

 

 

 



 
 

                               

            Worksheet - 3 (Based on chapters 5 and 6) 

  A. Write the use of following keyboard shortcuts in word and PowerPoint applications. 
        1. Ctrl + X          Cut 

        2. Ctrl + A          Select all 

        3. Ctrl + Y           Redo an undo action 

        4. Ctrl + Z           Undo an action 

        5. Ctrl + V           Paste 

 B. Encircle Word and Microsoft PowerPoint interface components in the given maze 
with  the help of given clues. 

      

 

 

 

  

 

 
1. A collections of slides.                                                                                        Presentation 

2.It holds different commands that are organized in groups.                                  Files 

3.It shows preview of your slides in Microsoft PowerPoint.                                  Slideshow 

4.A pane that holds speaker’s notes                                                                        Notes Pane 

5.A word file                                                                                                            Document 

6.It helps to scroll your presentation or document.                                                  Scroll bar 

7.An individual page of your presentation                                                               Slide 

8.It allows you to set margins of a document or slides.                                           Ruler 

9.A dotted rectangular box on a Microsoft Powepoint slide that contains objects. Placeholder 

      10. It displays name of the document                                                                        Title bar 



 

Ch-7 

    PROGRAMMING WITH LOGO           
➢ Keywords: - 

1. MSW LOGO: Stands for Microsoft Windows Language of Graphic Oriented. 

2. Primitives: Instructions or commands to move the turtle. 

3. Turtle’s home: The centre of the screen 

4. Turtle’s head: Pointed top of the turtle. 

5. Turtle’s tail: Bottom part of the turtle. 

 

                                              EXERCISES CORNER 
        

      A. Tick (    ) the correct answer: - 

      1. Which of the following you to set the color of turtle’s pen? 

           a. SETPC                              b. SETFC                                c. SETSC 

      2. Which primitive enables you to change background color of the main screen? 

           a. FENCE                              b. SETFLOODCOLOR           c. SETSCREENCOLOR  

      3. Which command is used to set color which is to be filled in a shape? 

           a. SETFLOODCOLOR          b. WRAP                                c. SETSCREENCOLOR 

      4. Which command creates a fence around the screen? 

            a. WRAP                                b. WALL                                c. FENCE 

      5. Which command converts turtle’s pen into an eraser? 

             a. PE                                      b. PD                                      c. PU 

 B. Write short form of the given commands. 

       1. HIDETURTLE                                                       HT 

       2. CLEARSCREEN                                                    CS 

       3. CLEARTEXT                                                         CT 

       4. PENDOWN                                                            PD 

       5. PENERASER                                                         PE  

C. Unscramble the logo commands. 

      1. FROAWDR                                                        FORWARD 

      2. SECOLPENORT                                               SETPENCOLOR 

      3. REAETP                                                             REPEAT 

      4. EFTLOOOODCLRS                                          SETFLOODCOLOR 

      5. EENCF                                                                FENCE 

D. Write the Logo commands to draw following using the REPEAT command. 

      1. A circle                                                               REPEAT 360 [FD1 RT1]                                  

      2. A triangle                                                            REPEAT 3 [FD 300 RT 120] 

      3. A decagon of side 60                                          REPEAT 10 [FD 100 RT 36] 



 

      4. An arc                                                                 ARC 180 50 

      5. A rectangle of side 30                                         FD 300 RT 90 FD 150 RT 90 

E. Short answer questions: - 

      1. What is LOGO? 

     → The LOGO stands for Language Oriented Graphic Oriented. In Logo, by writing codes 

you can draw objects, and perform calculations. 

     2. What is the turtle in LOGO? 

      → The main screen window holds a triangle, called turtle. The turtle moves according to the 

LOGO commands. 

      3. Write the use of the main screen? 

      → The main screen of LOGO is called Turtle’s area. With the help of LOGO commands we 

can move the turtle and draw various objects on main screen. 

      4. Write the use of the Execute button. 

      → Execute command button is used to execute the commands that you write in the command 

input box . 

                5.Give primitives used to lift the turtle’s pen up and to put down the pen. 

                  → Primitive for the turtle’s pen up – PENUP or PU  

                       Primitive for the turtle’s pen down – PENDOWN or PD 

 

                6.What is the REPEAT command? 

                   → The REPEAT primitive command allows us to give instruction in one line instead of 

giving in multiple lines. 

 

   F. Long answer questions:- 

                   1. Distinguish between CLEAN and   CLEARSCREEN commands? 

                   Ans:- . 1. CLEARSCREEN (CS) The CS primitive clears the main screen and brings the turtle back to its 

home (center of the screen.  

                                       Example: CS  

                                        CLEAN  

                                       The CLEAN primitive clears the main screen but does not send the turtle back to its home. It 

stays wherever it was.  

                                         Example: CLEAN  

                        2.How do you fill colour in a shape? Describe. 

                        Ans:-The Fill primitive fills colour which is defined by the SETFLOODCOLOR primitive in a closed 

shape. You must go inside the shape to use FILL primitive.  

                                        Command: FILL  

                                        Example: REPEAT 4 [FD 100 RT 90]  

                                                          PU  

                                                          FD 50  

                                                          RT 90  

                                                          FD 50  



 

                                                          SETFLOODCOLOR [255 0 0]  

                                                           FILL  

                             3.What is the use of SETFLOODCOLOR primitive? Explain using examples. 

                            Ans :-The SETFLOODCOLOR primitive is used to set a colour which is to be filled in a closed shape. 

By default, turtle draws with black pen. You can change colour of the turtle’s pen by using the 

SETPENCOLOR primitives.  

                                        Command: SETFLOODCOLOR [COLOR CODE]  

                                        Example: SETFLOODCOLOR [255 0 0]  

                              4. Distinguish between FENCE and WRAP commands.  

                                 Ans: -FENCE Primitive The FENCE primitive creates a fence around the screen so that the turtle 

cannot go beyond the screen.  

                                        Command: FENCE  

                                        Example: FENCE  

                                        FD 600  

                                        WRAP Primitive  

                                        The WRAP primitive allows the turtle to appear on the other end of the screen, once the 

edge is reached.  

                                        Command: WRAP  

                                        Example: WRAP  

                                        RT 90  

                                        FD 600  

                              5.Compare HT and ST commands.  

                                 Ans :-HIDETURTLE (HT)  

                                        The HT primitive makes the turtle invisible from screen.  

                                         Example: HT  

                                         SHOW TURTLE (ST)  

                                         The ST primitive makes the turtle visible, if it is invisible.  

                                          Example: ST 

                    

                 

                                         BRAIN TEASER 
               

➢ Identify the mistakes in the given LOGO commands. Rewrite them correctly. 

                1. Fd 100 RR 20   -     FD 100 RT 20 

                2. HT 56                -     HT   

                3. PU  30               -     PU FD 50 

                4. SETFILL          -    SETELOODCOLOR                                                                   

                                                                                                                                                                          



 

                                    Ch-8 

           WORKING WITH SCRATCH 
➢ Keywords: - 

1. Sprite: Any object on the stage of scratch. 

2. Stage: The area in Scratch where you see the output of the program on execution. 

3. Blocks description area: The ten categories of color-coded blocks that used to create programs in       

Scratch. 

  4. Scripts area: The area in Scratch where you add the blocks of the Scripts Area. 

5. Scripts area: The area in Scratch where you stack blocks to perform action on the Stage 

6.Costume:  A visual image of the sprite.  

7. Blocks:  Prewritten codes             

     EXERCISES CORNER   

        A. Tick ( ) the correct answer: - 

          1. A small graphic that performs actions according to your instructions on the stage is called :       

                  a. Sprite                            b. Costume                     c. Turtle              

          2. Which of the following windows is used to create and sprites and costumes? 

                  a. Paint Editor                  b. Drawing                       c. Canvas Editor 

          3. Constume are used to create       

                  a. illusion of movement               b. frames          c.  none of these   

           4. Which of the following buttons do you click to add a new sprite? 

                    

 

                5.Which of the following do you use to grow a spirite? 

               

        

   B. Fill in the blanks. Compare your answers with your classmates’ answers. 

                                     



 

                    Options         Coustumes      Cat      thumbnails       fill           

          

            1.Cat is the default sprite in Scratch. 

            2.The Spirit list contains  thumbnails of spirites. 

            3.Paint Editor, the fill tool fills color in an object bar holds options for the select.                  

       4.In Paint Editor, the option bar holds options for the selected tool. 

       5.The constumes tab is clicked to view the available costumes of a sprite. 

       C. State ‘True’ or ‘False’:- 

      1. Sprites can be deleted from the stage.                                               True  

      2.You cannot change the customes of spirites.                                      False 

      3.Text tool allows you to write text.                                                      True 

      4. Using Undo button you can cancel your last performed action.        True 

     5. Shrink button enables you to shrink sprite or any other object.          True 

D. Match the following: - 

             Column A                                  Column B 

1. a. Text                ( 4 ) 

2. b. Shrink            ( 1 ) 

3. c. Eraser             ( 5 )   

4. d. Select              ( 2 ) 

5. e. Stamp             ( 3 ) 

 E. Short answer questions:- 

    1.What is Scratch? 

      Ans:- Scratch is a programming language used to create interactive stories, animations, games, music 

and art .  

      2. State the role of a sprite in Scratch. 

         Ans:- A sprite is small graphic that performs actions according to your instructions. 

         3. What is a costume? 

         Ans:- A visual image of sprite is called a costume. Sprites can have multiple costumes. Costumes are 

used to   create the illusion of movement  

         4.Write the use of the Paint Editor. 

         Ans:- The Paint Editor window holds many buttons and tools used to draw and edit sprites 



 

5.Give names of any two tools of the Paint Editor. 

 Ans:- i. Paintbrush                   ii. Line 

    F. Long answers questions:- 

        1. How do you add a new sprite? Describe the steps? 

         Ans:- 1. To add a new sprite or to change a sprite, follows these steps:  

                         i. Click the Choose a sprite from library  button present next to New Sprite heading.  

                        ii. The sprite library opens up. Choose a category and a sprite of your choice. For 

example choose   Butterfly1 in Animals category.  

                        iii. Click OK to insert sprite on the stage. 

        2. Distinguish between Grow and Strink tools. 

         Ans:- Shrink Button: i) Shrink Button enables you to shrink sprite or any other object.  

                                                ii)  

                                Grow Button: i) Grow button enables you to grow the sprite or any other object.  

                                                ii)  

       3. Write a note on the stage in Scratch. 

         Ans:- A white area on the screen is called stage. It is the area where all of the action takes place. 

It holds a   green flag and red stop . The green flag allows you to start your main programs 

and the red stop ends them. The stage is 480 units wide and 360 units tall. It is divided into 

an x-y grid. The middle of the stage has an x-coordinate of 0 and a y-coordinate of 0. 

      4. What is backdrop? Write the steps to add a new backdrops? 

        Ans:- The Background area of the stage is called Backdrop.  

                    Steps to add new Backdrop:  

                        i. Select thumbnail of Stage 1 backdrop in Sprite List area.  

                       ii. Click the Choose a backdrop from library button present at bottom left corner of the 

screen.  

                      iii. The Backdrop Library appears. Select Nature category → underwater3 and click OK. 

Selected backdrop appears on the stage. 

5.Describe any five tools of the Paint Editor toolbar? 

Ans:- Five tools of Paint editor toolbar are:- 



 

                           

                                Brain Teaser 

➢ Complete the following crossword using the given clues:- 

              

    

         

 

 

 

            

             

 

 

 

 

 

 

 

            1. It cancels undo action. 

            2. It create a copy of an objects. 

            3.It rubs out part of an object or the complete object. 

            4.These are visual images of a sprite. 

            5. It grows the size of an object 

                           



 

                                Ch-9 
                      The Internet 
 

➢ Keywords: - 
 1. Internet – A global network of interconnected computers. 

 2. Web page – A hypertext document on the World Wide Web. 

 3. Home Page – Introduction or first page of a website. 

 4. ARPANET – Advanced Research Project Agency Network. 

 5. HTML – Hypertext markup language, a language that is used to create web pages.  

                                                    Exercise Corner   

A. Tick (  √  )  the correct option. Cross -check your answers with your classmate. 

         1.A standard set of rules that computer networks or network devices follow when transmitting and  

            receiving data is called  ________ . 

             a. prototype                              b. protocol                           c. standards 

         2.The first version of the Internet was Known as _______________________. 

            a. NSFnet                                  b. ARPANET                      c. Intranet 

         3. URL stands for 

            a. Uniform Resource Locator 

            b. Unique Resource Locator 

            c. Union Resource Locator 

       4.Who provides an Internet connection? 

           a. ISP                                         b. IAS                                    c. IPS               

       5. Modem is the abbreviation of: 

           a. Modulator-Demodulator 

           b. Demodulator 

           c. Modulator         

B. Fill in the blanks. Compare your answers with your classmates’ answers :- 

       

      homepage        Internet       Tim Berners-Lee       TCP/IP         Web browser 

 

     1.The internet is a global network of interconnected computers. 



 

     2. The WWW was invented by Tim Berners-Lee in 1990. 

     3. A web browser is application that enables the users to locate and access   the wed pages. 

     4. The TCP/IP protocol is needed for the working of the Internet. 

     5. The main or introductory page of a website is called the home page . 

C. State ‘True’ or ‘False’ :- 

    1. The IP was invented by Tim Berners-Lee in 1990.                    False 

     2. The WWW is governed by Hypertext Transfer Protocol.          True 

     3. To send an email, you must have an email address.                   True 

     4. Google Chrome is a web browser.                                              True 

  D. Match the following columns: - 

               Column A                                      Column B 

      1. HTTP                                                  a. Web browser                              4                   

       2. Airtel                                                   b. Internet Protocol                        3 

       3. IP                                                         c. Hypertext Transfer Protocol      1 

       4. Mozilla Firefox                                   d. Internet Service Provider           2 

E. Short answer questions: - 

       1. What is Internet ? 

       Ans:- The Internet is a global network of computer networks which spans across the world. 

        2.What is a protocol? 

       Ans:- A Protocol is a standard set of rules that computer network or network devices follow 

when transmitting and receiving data. 

        3. Describe the WWW? 

        Ans:- The WWW is a subset of the Internet which contain huge amount of information in form 

of text, graphics, audio, video, etc. that can be accessed via Internet. 

        4. What is TCP/IP ? 

         Ans:- When working on Internet TCP/IP is used to transfer data from one computer to another 

over the Internet. 

         5. What is URL? 

         Ans:- URL stands for Uniform Resource Locator. It refers to the unique address or location of a 

website. 

   F. Long answer questions :- 



 

    1. Describe the history of Inernet? 

          Ans:- The history of the Internet began with the development of electronic computers in the 

1950s.   Later in 1969, the Department of Defence of the United States of America set up a 

network ANSWER KEY 32 of computer called ARPANET. The network connected one 

computer in California with three in Utah.  

                This was the first step towards the creation of the Internet. NSFnet was developed in 1986. 

       2. Explain the term we browser. Also, write names of any five we browser? 

      Ans:- A Web browser is a software application that enables the users to locate and access the 

web page. Browsers translate the basic HTML code that allow us to see images, text, 

videos and listen to audios. A web browser gets in contact with the web server and request 

for the information, the web server receives the information and display it in the browser.  

                 Some web browsers are: Microsoft Internet Explorer, Mozilla Firefox, Google Chrome,  

                 Safari, and Opera 

  

      3.Distinguished between a web page and a website? 

       Ans:- 

 

 

 

 

 

 

 

 

 

 

 

      4. How does data travel over the Internet? Describe. 

     Ans:- Modem is abbreviation for Modulator-Demodulator. It is used for data transfer from one 

computer network to another computer network through telephone lines. The computer network 

works in digital mode, while analog technology is used for carrying massages across phone lines.                        



 

                               

                                                    Brain Teaser 

❖ Unscramble the following to form correct words:- 

1. INEERNTT              ------           INTERNET 

2. APETRAN               ------           ARPANET 

3. WERRBBOSE         ------           WEB BROWSER 

4. HOAMPGE              ------            HOMEPAGE 

5. PROLOTCO             ------            PROTOCOL 

                     Worksheet - 4 (Based on chapters 7 to 9) 
  A. Unscramble the following LOGO commands an write use use of each:- 

      
 
 
 
 
 
 
 
 

 
 

B. Write the use of following blocks of scratch. Also tick the category in which these 
blocks are present:- 

    
 

 

 

 

C. Give names of any two web browsers:- 

 
         1. Internet Explorer                    2. Google Chrome 

                                  



 

                                  SA-2  EXTRA QUESTIONS 

   A. Fill in the blanks.  

                                1. ____________ is an area in Scratch where you stack blocks to perform action on the Stage.  

                                2. From the _____________ menu, Picture, Text Box, Clip Art, Chart etc. can be accessed.   

                                3. Charles Babbage developed a fully automatic computing device, the __________ engine.   

                                4. _________ is the technology used in printing the code at the bottom of bank cheques.   

                                5. ___________ moves text from one position to another without creating a duplicate.  

                      B. Give the full form.  

                                1. DVD ________________________________________________________________  

                                2. WWW ________________________________________________________________  

                                3. URL ________________________________________________________________  

                                4. ARPANET ________________________________________________________________  

                                5. HTTP ________________________________________________________________  

                        C. State ‘True’ or ‘False’.  

                                1. A vertical blinking line is called pointer.  

                                2. Linux is an operating system.  

                                3. The CU controls all the operations done on a computer.  

                                4. All data is stored in a computer in the form of 0’s and 1’s.  

                                5. WWW is governed by World Wide Web.  

                     D. Define the following.  

                                1. Screensaver 

                                     ____________________________________________________________________________  

                                2. Taskbar  

                                     ____________________________________________________________________________  

                                3. Digital Versatile Disc  

                                     ____________________________________________________________________________ 

                                4. Ribbon  

                                      ____________________________________________________________________________  

                                5. LOGO 

                                       ___________________________________________________________________________ 

    E. Write the uses of following keyboard shortcuts.  

             1. Ctrl + O ____________________________________________________________________________ 

2. Ctrl + N ____________________________________________________________________________ 

3. Ctrl + Z ____________________________________________________________________________ 

4. Ctrl + A ____________________________________________________________________________ 

5. Ctrl + P ___________________________________________________________________________ 

     F. Answer the following questions.  

            1. Write steps to set screensaver. 

____________________________________________________________________________ 

____________________________________________________________________________ 

____________________________________________________________________________ 



 

            2. What is Auxiliary storage? Explain any two. 

____________________________________________________________________________ 

____________________________________________________________________________ 

____________________________________________________________________________  

            3. What is printer? Describe its types. 

____________________________________________________________________________ 

____________________________________________________________________________  

            4. What is booting? 

____________________________________________________________________________ 

____________________________________________________________________________ 

____________________________________________________________________________  

             5. What is colouring primitives? Explain using examples. 

____________________________________________________________________________ 

____________________________________________________________________________ 

____________________________________________________________________________ 

    

➢ Label the picture of scratch interface: - 



 

➢ Label the Microsoft PowerPoint interface:- 

➢ Label the picture of Logo interface  


